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1'AFFIX CUSTOMER NO. LABEL ABOVE 1'. ~0 
IN THE UNITED STATES PATENT AND TRADEMARK OFFICE 

UTILITY APPLICATION AND FEE TRANSMITTAL §(1.53(b)) 

Commissioner for Patents 
Box Patent Application 
Washington, D.C. 20231 

Sir: 

Transmitted herewith for filing is the patent application of 

Inventor(s) names and addresses: Keith R. McNally. San Diego CA: William H. Roof. San 
Diego. CA' Richard Bergfeld. Chatsworth. CA 

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS 
SYSTEM WITH MENU GENERATION 

Enclosed Are: 

page(s) of specification 
page( s) of Abstract 
page( s) of claims 
sheets (Figs. 1-7) of [g) Formal 0 Informal drawings 
page( s) of Declaration and Power of Attorney 

0 Unsigned 
D Newly Executed 
IZJ Copy from prior application 
D Deletion of inventors including Signed Statement under 37 C.P.R. § 1.63( d)(2) 
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Docket No. 3125-4002US1 

REQUEST AND CERTIFICATION UNDER 35 U.S.C. §122(b)(2)(B)(i) (form 
PTO/SB/35) 
As indicated on the attached Request and Certification, Applicant(s) certify that the 
invention disclosed in the attached application HAS NOT and WILL NOT be the subject of 
an application flied in another country, or under a multilateral agreement, that requires 
publication at eighteen months after filing. Applicant(s) therefore request(s) that the 
attached application NOT be published under 35 U.S.C. §122(b). 

Incorporation by Reference: 

[g) The entire disclosure of the prior application, from which a copy of the combined 
Declaration and Power of Attorney is supplied herein, is considered as being part of 
the disclosure of the accompanying application and is incorporated herein by 
reference. 

D Deletion of Inventors (3 7 C.F .R. § 1.63( d) and § 1.33(b) 

D 

D 
D 

Signed statement attached deleting inventor(s) named in the prior application serial no. 
__ , filed __ . 

Microfiche Computer Program (Appendix) 

D page(s) of Sequence Listing 

D computer readable disk containing Sequence Listing 

D Statement under 37 C.P.R. §1.821(f) that computer and paper copies of the Sequence 
Listing are the same 

Assignment Papers (assignment cover sheet and assignment documents) 

D A check in the amount of$40.00 for recording the Assignment 

D Charge the Assignment Recordation Fee to Deposit Account No. 13-4500, Order 
No. __ . 

C8J Assignment Papers filed in the parent application Serial No. 09/400.413 

Certification of chain of title pursuant to 37 C.P.R. §3.73(b) 

Priority is claimed under 35 U.S.C. § 119 for: 
Application No(s). __ ,filed __ , in __ (country). 

D Certified Copy of Priority Document(s) [ __ ] 

D filed herewith 

D filed in application Serial No. filed __ . 

D English translation document(s) [ __ ] 

D filed herewith 

0 filed in application Serial No. __ , filed __ . 

D Priority is claimed under 35 U.S.C. §119(e) for: 
Provisional Application No. __ , filed __ . 

-2-
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Docket No. 3125-4002US1 

D Information Disclosure Statement 

D Copy of [ ] cited references 

D PTO Form-1449 

D References cited in parent application Serial No. __ , filed __ . 

0 Related Case Statement under 37 C.F.R. § 1.98(a)(2)(iii) 

0 A copy of related pending U.S. Application(s) Serial No(s): __ ,filed __ , 
respectively, is attached hereto. 

0 A copy of related pending U.S. Application(s) entitled, __ , filed __ to 
inventor(s) __ ,respectively, is attached hereto. 

0 A copy of each related application(s) was submitted in parent application serial no. 
__ , filed __ . 

Preliminary Amendment 

Return receipt postcard (MPEP 503) 

This is a [gj continuation 0 divisional D continuation-in-part of prior application 
serial no. 09/400 413, filed September 21. 1999, to which priority under 35 U.S. C. § 120 
is claimed. 

0 Cancel in this application original claims __ of the parent application before 
calculating the filing fee. (At least one original independent claim must be retained 
for filing purposes.) 

[8:1 A Preliminary Amendment is enclosed. (Claims added by this Amendment have 
been properly numbered consecutively beginning with the number following the 
highest numbered original claim in the prior application). 

The status of the parent application is as follows: 

0 A Petition for Extension of Time and a Fee therefor has been or is being filed in the 
parent application to extend the term for action in the parent application until __ . 

D A copy of the Petition for Extension of Time in the co-pending parent application is 
attached. 

[8:1 No Petition for Extension of Time and Fee therefor are necessary in the co-pending 
parent application. 

0 Please abandon the parent application at a time while the parent application is pending or 
at a time when the petition for extension oftime in that application is granted and while 
this application is pending has been granted a filing date, so as to make this application 
co-pending. 

D Transfer the drawing(s) from the parent application to this application 

0 Amend the specification by inserting before the first line the sentence: 
This is D continuation D divisional D continuation-in-part of co-pending application 
Serial No. __ , filed __ . 

-3-
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Docket No. 3125-4002US1 

I. CALCULATION OF APPLICATION FEE 

Basic Fee 
Number Filed Number Extra Rate $740.00/370.00 

Total Claims* 102-20 = 82x $18.00/$9.00 $ 738.00 

Independent Claims 13-3= lOx $84.00/ $42.00 $ 420.00 

[8J Multiple Dependent Claims Ifmarked, add fee of$280.00 ($140.00) $ 140.00 

* Reflects total number of claims for fee purposes, with multiple dependent claims 

being counted according to 37 C.F.R. §1.75(c) 

TOTAL: $ 1668.00 

Small entity status is or has been claimed. Reduced fees under 37 C.P.R. § 1.9 (f) paid 
herewith 
$1668.00. 

[8J 

D 
A check in the amount of$1668.00 in payment of the application filing fees is attached. 

Charge fee to Deposit Account No. 13-4500, Order No. __ . A DUPLICATE COPY 
OF THIS SHEET IS ATTACHED. 

[8J The Commissioner is hereby authorized to charge any additional fees which may be 
required for filing this application pursuant to 37 CFR § 1.16, including all extension of 
time fees pursuant to 37 C.F.R. § 1.17 for maintaining copendency with the parent 
application, or credit any overpayment to Deposit Account No. 13-4500, Order No. 3125-
4002USI. A DUPLICATE COPY OF THIS SHEET IS ATTACHED. 

Dated: November 1. 2001 

Correspondence Address: 

MORGAN & FINNEGAN, L.L.P. 
345 Park A venue 
New York, NY 10154-0053 
(212) 758-4800 Telephone 
(212) 751-6849 Facsimile 

660999 vi 

By: 

Respectfully submitted, 
MORGAN & FINNEGAN, L.L.P. 

0 

egistration No. 36 231 
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Docket No. 3125-4002US1 

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE 0~ 
Applicant(s): -· == ... =-McNally et al. -~~ 

~ .... ~0' Group Art Unit: 2173 (parent case) Q_, 

Continuation of 09/400,413 :;:s~::: Serial No.: 

Examiner: Cao Nguyen (parent c~J -
Filed: Herewith 

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS 
SYSTEM WITH MENU GENERATION 

EXPRESS MAIL CERTIFICATE 

Express Mail Label No.: EL606933364US 

Date ofDeposit: November 1, 2001 

I hereby certify that the following attached paper(s) and/or fee 

I. Utility Application and Fee Transmittal Form; 
2. Combined Declaration and POA; 
3. Preliminary Amendment; 
4. Check in the amount of$1,668.00; 
5. Patent Application (Specs. 26 pgs., Claims 20 pgs. Abstract 1 pg.) 
6. Formal Drawings (6 sheets- Figs. 1-7) 
5. Return Receipt Postcard. 

is being deposited with the United States Postal Service "Express Mail Post Office to Addressee" 
service under 37 C.P.R. §1.10 on the date indicated above and is addressed to BOX CPA, 
Commissioner for Patents, Washington, D.C. 20231. 

Correspondence Address: 

MORGAN & FINNEGAN, L.L.P. 
345 Park A venue 
New York, NY 10154-0053 
(212) 758-4800 Telephone 
(212) 751-6849 Facsimile 

661254 vi 

Jesus Raul Remedios 
(Typed or printed name of person mai · 

(Signature of 



 6Petitioners' Exhibit 1007, Page

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE 

APPLICANTS: McNally et al. GROUP ART UNIT:2173 (parent case) 

SERIAL NO.: Continuation of09/400,413 EXAMINER: Cao Nguyen (parent case) 

FILED: HEREWITH 

FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU GENERATION 

COMMISSIONER FOR PATENTS 
Washington, D.C. 20231 

PRELIMINARY AMENDMENT 

Responsive to the Final Rejection in the Parent Case dated May 22, 2001, 

Applicants respectfully request reconsideration in view of the amendment and following 

remarks. No fees are believed due. However, in the event that any fees are necessitated by this 

response, the Commissioner is hereby authorized to charge our Deposit Account 13-4500, Order 

No. 3125-4002US1. 

IN THE CLAIMS 

Please add new claim 93 as follows. 

93. (new) The information management and synchronous 

hd communication system of claim 45 wherein a non-simultaneous protocol is used to acknowledge 

receipt of the data at the valet parking base station. 

REMARKS 

I. Status of the Claims 

Claims 1-92 are pending in this application, with claim 93 being added by 

this Amendment. 

Claims identical to claims 1-19,20-28, and 35-39 were rejected in the 

parent case under 35 U.S. C. 102(e) as being anticipated by Cupps et al. In the parent case these 

659742 vi 
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claims were identified by numbers 1-19, 31-39, and 50-54 respectively. This Amendment will 

refer to the claims by their new numbers. 

Claims identical to claims 29-34 and 40-41 were rejected in the parent 

case under 35 U.S.C. 103(a) as being unpatentable over Cupps in view ofBehr. In the parent 

case these claims were identified by numbers 44-49 and 56-57 respectively. This Amendment 

will refer to the claims by their new numbers. 

Of the pending claims for which identical claims were rejected in the 

parent application, claims 1, 12, 20, 29, 32, and 33 are independent. 

II. Rejections Under 35 U.S.C. 102(e) 

In the parent application the Examiner rejected claims identical to 

independent claims 1, 12, and 20 under 35 U.S.C. 102(e) as being anticipated by Cupps et al. 

With regard to claims identical to independent claims 1, 12, and 20 of the 

present application, the Examiner argues that at lines 35-65 of column 9 and in figs. 2 and 3a-3f, 

Cupps discloses information synchronization involving a second or modified menu. However 

Applicants respectfully disagree. 

The first section cited by the examiner, column 9 lines 35-65, fails to 

disclose information synchronization involving a second or modified menu, nor any other sort of 

information synchronization. This section instead discloses a customer providing to an online 

ordering machine registration information, location information, time of day information, and an 

indication of the type of service sought (e.g., takeout or delivery). 

The second section cited by the examiner, Fig. 2, is a system overview 

showing an online ordering machine component, a client machine component connected to the 

online ordering machine via a network, and telephone and fax components connected to the 

online ordering machine via standard telephone lines. Also shown are various elements of the 

online ordering machine and the client machine. However, nowhere in the figure or its 

corresponding disclosure is there any indication of synchronization involving a second or 

659742 v l 



modified menu. More generally, there is no disclosure of information synchronization occurring 

between any components of the system, nor is there disclosure of any other sort of information 

synchronization. 

The third section cited by the examiner, Figs. 3a-3f, fails to disclose 

synchronization involving a second or modified menu and instead discloses the "schema" -that 

is the organization and structure - of the order database 128 (see Cupps, Col. 5 Ln. 21). Nowhere 

in the figures or in the corresponding disclosure is there even any indication that the order 

database is involved in any sort of information synchronization. In fact, there is no disclosure of 

any sort of information synchronization in this section. 

Furthermore, the remainder of the Cupps disclosure also fails to disclose 

synchronization involving a second or modified menu, nor any other sort of information 

synchronization. 

claim 1 wherein: 

Accordingly, Cupps fails to disclose at least the aspect of independent 

" ... data comprising the second menu is synchronized 
between the data storage device connected to the 
central processing unit and at least one other 
computing device ... " 
(emphasis added) 

Similarly, Cupps also fails to disclose at least the aspect of independent 

claim 12 wherein: 

claim 26 wherein: 

659742 v i 

" ... data comprising the modified menu is synchronized 
between the data storage device and at least one other 
computing device . .. " 
(emphasis added) 

Furthermore, Cupps fails to disclose at least the aspect of independent 

" .. . synchronizing the data comprising the second menu 
between the storage device and at least one other data 
storage medium, wherein the other data storage medium is 
connected to or is part of a different computing device .. . " 

Petitioners' Exhibit 1007, Page 8 
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(emphasis added) 

The disclosure of the present invention explains that according to the 

claimed synchronization there is, for example: 

" ... fast synchronization between a central database and 
multiple handheld devices, synchronization and 
communication between a Web server and multiple handheld 
devices, a well-defined API that enables third parties such as 
POS companies. affinity program companies and internet 
content providers to fully integrate with computerized 
hospitality applications. real-time communication over the 
internet with direct connections or regular modem dialup 
connections and support for batch processing that can be 
done periodically throughout the day to keep multiple sites in 
synch with the central database." 
(see disclosure, p. 7 ln. 21- p. 8 ln. 4; emphasis added) 

As another example, the disclosure of the present invention notes that 

according to such synchronization: 

" ... a reservation made online can be automatically 
communicated to the backoffice server and then 
synchronized with all the wireless handheld devices 
wirelessly. Similarly, changes made on any of the wireless 
handheld devices are reflected instantaneously on the 
back office server Web pages and the other handheld 
devices." 
(see disclosure, p. 8 ln. 13-16; emphasis added) 

In light of the above, Applicants submit that independent claims 1, 12, and 

20 are in condition for allowance. As claims 2-11, 13-19, 21-28, 35-39, 49-68, and 84-92 depend 

therefrom, these claims, for at least the above-identified reasons, are also thought to be 

allowable. 

659742 vl 
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III. Rejections Under 35 U.S.C. 103fa) 

In the parent application the Examiner rejected claims identical to 

independent claims 29, 32, and 33 under 35 U.S.C. 102(e) as being unpatentable over Cupps in 

view of Be hr. 

As explained above, Cupps fails to disclose any sort of information 

synchronization. Furthermore, Applicants find no disclosure in Behr of any sort of information 

synchronization, nor does the Examiner provide any reference to such disclosure in Behr . 

Applicants therefore submit that Cups and Behr, alone or in combination, 

fail to disclose, teach, or suggest at least the aspect of independent claim 29 wherein: 

11 
••• a~~lications or data are synchronized wirelessly 

between the central database and at least one wireless 
handheld com~uting device and wherein the 
applications program interface and communications 
control module establish a seamless link between the 
data in the central database and the data on the 
wireless handheld computing device .. 11 

(emphasis added) 

Similarly, Cups and Behr, alone or in combination, fail to disclose, teach, 

fG1 or suggest at least the aspect of independent claim 32 wherein: 

" ... hospitality applications or data are synchronized 
between the central database at least one wireless com~uting 
device and at least one wireless ~aging or bee~er device and 
wherein messaging to the wireless paging or beeper device is 
enabled directly from the operator interface of the wireless 
computing device." 
(emphasis added) 

Furthermore, Cups and Behr, alone or in combination, fail to disclose, 

teach, or suggest at least the aspect of independent claim 33 wherein: 

659742 vl 

" ... a~~lications or data are synchronized between the 
central database and the second storage medium and wherein 
the applications program interface and communications 
control module establish a seamless link between the data in 
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the central database and the data on the second storage 
medium." 
(emphasis added) 

The Examiner also states: 

"Behr teaches wirele,ss handheld computing device on which 
hospitality application (see col. 14, lines 1-57)." 

Applicants respectfully disagree. Behr discloses "a method of providing 

route guidance information and other information from a base unit to a mobile unit in response to 

a request from the mobile unit" (see Behr, Col. 4 Ln. 28-31 ). Behr explains that the mobile unit 

sends the request for route guidance as a "query message 120" including a "destination field 

144" and a "destination type field 146", and, for example, that the "destination type field 146 

may be 'restaurant', and the destination field 144 may be 'McDonald's'" (see Behr, Col. 14 Ln. 

37-44). Behr also discloses that other specifiable destinations include "airport[s]" and 

"museum[s]" (see Behr, Col. 14 Ln. 42). 

However, Applicants submit that simply stating that a mobile unit may 

request from a navigation system directions to a restaurant does not constitute disclosure of a 

hospitality software application. As known in the art, a hospitality software application is, for 

example, a piece of software used to provide operational solutions in hospitality industries such 

as restaurants and hotels concerning, for example, food ordering, menus, wait-lists and 

reservations. Accordingly, Applicants submit that Behr fails to teach a "wireless handheld 

computing device on which hospitality application" as suggested by the Examiner. 

In light of at least the above, Applicants submit that independent claims 

29, 32, and 33 are in condition for allowance. As claims 30, 31, 34, 40-48, and 93 depend 

therefrom, these claims, for at least the above-identified reasons, are also thought to be 

allowable. 

659742 vl 
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IV. Conclusion and Authorization 

Applicants believe that all pending claims are allowable over the cited art. 

The Commissioner is hereby authorized to charge any additional fees 

which may be required for this amendment, or credit any overpayment to Deposit Account No. 

13-4500, Order No. 3125-4002. A DUPLICATE OF THIS DOCUMENT IS ATTACHED. 

In the event that an extension of time is required in addition to that 

requested in a petition for an extension of time, the Commissioner is requested to grant a petition 

for that extension of time which is required to make this response timely and is hereby 

authorized to charge any fee for such an extension of time or credit any overpayment for an 

extension of time to Deposit Account No. 13-4500, Order No. 3125-4002US1. A DUPLICATE 

OF THIS DOCUMENT IS ATTACHED. 

November 1, 2001 
MORGAN & FINNEGAN, L.L.P. 
345 Park A venue 
New York, NY 10154 
(212)758-4800 I (212)751-6849 (facsimile) 

659742 vl 

Respectfully submitted, 
MORGAN &FINNEGAN,L.L.P. 
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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE 

APPLICANTS: McNally et al. GROUP ART UNIT:2173 (parent case) 

SERIAL NO.: Continuation of 09/400,413 EXAMINER: Cao Nguyen (parent case) 

FILED: HEREWITH 

FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU GENERATION 

COMMISSIONER FOR PATENTS 
Washington, D.C. 20231 

PRELIMINARY AMENDMENT 

Responsive to the Final Rejection in the Parent Case dated May 22, 2001, 

Applicants respectfully request reconsideration in view of the amendment and following 

remarks. No fees are believed due. However, in the event that any fees are necessitated by this 

response, the Commissioner is hereby authorized to charge our Deposit Account 13-4500, Order 

No. 3125-4002US1. 

IN THE CLAIMS 

Please add new claim 93 as follows. 

93. (new) The information management and synchronous 

communication system of claim 45 wherein a non-simultaneous protocol is used to acknowledge 

receipt of the data at the valet parking base station. 

REMARKS 

I. Status of the Claims 

Claims 1-92 are pending in this application, with claim 93 being added by 

this Amendment. 

Claims identical to claims 1-19,20-28, and 35-39 were rejected in the 

parent case under 35 U.S.C. 102(e) as being anticipated by Cupps et al. In the parent case these 

659742 vi 
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claims were identified by numbers 1-19, 31-39, and 50-54 respectively. This Amendment will 

refer to the claims by their new numbers. 

Claims identical to claims 29-34 and 40-41 were rejected in the parent 

case under 35 U.S.C. 103(a) as being unpatentable over Cupps in view ofBehr. In the parent 

case these claims were identified by numbers 44-49 and 56-57 respectively. This Amendment 

will refer to the claims by their new numbers. 

Of the pending claims for which identical claims were rejected in the 

parent application, claims 1, 12, 20, 29, 32, and 33 are independent. 

II. Rejections Under 35 U.S.C. 102(e.) 

In the parent application the Examiner rejected claims identical to 

independent claims 1, 12, and 20 under 35 U.S.C. 102(e) as being anticipated by Cupps et al. 

With regard to claims identical to independent claims 1, 12, and 20 of the 

present application, the Examiner argues that at lines 35-65 of column 9 and in figs. 2 and 3a-3f, 

Cupps discloses information synchronization involving a second or modified menu. However 

Applicants respectfully disagree. 

The first section cited by the examiner, column 9lines 35-65, fails to 

disclose information synchronization involving a second or modified menu, nor any other sort of 

information synchronization. This section instead discloses a customer providing to an online 

ordering machine registration information, location information, time of day information, and an 

indication of the type of service sought (e.g., takeout or delivery). 

The second section cited by the examiner, Fig. 2, is a system overview 

showing an online ordering machine component, a client machine component connected to the 

online ordering machine via a network, and telephone and fax components connected to the 

online ordering machine via standard telephone lines. Also shown are various elements of the 

online ordering machine and the client machine. However, nowhere in the figure or its 

corresponding disclosure is there any indication of synchronization involving a second or 

659742 vl 
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-~ 

modified menu. More generally, there is no disclosure of information synchronization occurring 

between any components of the system, nor is there disclosure of any other sort of information 

synchronization. 

The third section cited by the examiner, Figs. 3a-3f, fails to disclose 

synchronization involving a second or modified menu and instead discloses the "schema" - that 

is the organization and structure- of the order database 128 (see Cupps, Col. 5 Ln. 21). Nowhere 

in the figures or in the corresponding disclosure is there even any indication that the order 

database is involved in any sort of information synchronization. In fact, there is no disclosure of 

any sort of information synchronization in this section. 

Furthermore, the remainder of the Cupps disclosure also fails to disclose 

synchronization involving a second or modified menu, nor any other sort of information 

synchronization. 

claim 1 wherein: 

claim 12 wherein: 

claim 26 wherein: 

659742 vl 

Accordingly, Cupps fails to disclose at least the aspect of independent 

" ... data comprising the second menu is synchronized 
between the data storage device connected to the 
central processing unit and at least one other 
computing device ... " 
(emphasis added) 

Similarly, Cupps also fails to disclose at least the aspect of independent 

" ... data comprising the modified menu is synchronized 
between the data storage device and at least one other 
computing device .. . " 
(emphasis added) 

Furthermore, Cupps fails to disclose at least the aspect of independent 

" ... synchronizing the data comprising the second menu 
between the storage device and at least one other data 
storage medium, wherein the other data storage medium is 
connected to or is part of a different computing device .. . " 
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(emphasis added) 

The disclosure of the present invention explains that according to the 

claimed synchronization there is, for example: 

" .. . fast synchronization between a central database and 
multiple handheld devices, synchronization and 
communication between a Web server and multiple handheld 
devices, a well-defined API that enables third parties such as 
POS companies. affinity program companies and internet 
content providers to fully integrate with computerized 
hospitality applications. real-time communication over the 
internet with direct connections or regular modem dialup 
connections and support for batch processing that can be 
done periodically throughout the day to kee_p multiple sites in 
synch with the central database." 
(see disclosure, p. 7ln. 21- p. 8ln. 4; emphasis added) 

As another example, the disclosure of the present invention notes that 

according to such synchronization: 

" ... a reservation made online can be automatically 
communicated to the backoffice server and then 
synchronized with all the wireless handheld devices 
wirelessly. Similarly, changes made on any of the wireless 
handheld devices are reflected instantaneously on the 
backoffice server Web pages and the other handheld 
devices." 
(see disclosure, p. 8ln. 13-16; emphasis added) 

In light of the above, Applicants submit that independent claims 1, 12, and 

20 are in condition for allowance. As claims 2-11, 13-19, 21-28, 35-39,49-68, and 84-92 depend 

therefrom, these claims, for at least the above-identified reasons, are also thought to be 

allowable. 

659742 vl 
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III. Rrjections Under 35 U.S.C. 103(a) 

In the parent application the Examiner rejected claims identical to 

independent claims 29, 32, and 33 under 35 U.S.C. 102(e) as being unpatentable over Cupps in 

view ofBehr. 

As explained above, Cupps fails to disclose any sort of information 

synchronization. Furthermore, Applicants find no disclosure in Behr of any sort of infonnation 

synchronization, nor does the Examiner provide any reference to such disclosure in Behr . 

Applicants therefore submit that Cups and Behr, alone or in combination, 

fail to disclose, teach, or suggest at least the aspect of independent claim 29 wherein: 

" ... applications or data are synchronized wirelessly 
between the central database and at least one wireless 
handheld computing device and wherein the 
applications program interface and communications 
control module establish a seamless link between the 
data in the central database and the data on the 
wireless handheld computing device .. " 
(emphasis added) 

Similarly, Cups and Behr, alone or in combination, fail to disclose, teach, 

or suggest at least the aspect of independent claim 32 wherein: 

" ... hospitality a,pplications or data are synchronized 
between the central database. at least one wireless computing 
device and at least one wireless paging or beeper device and 
wherein messaging to the wireless paging or beeper device is 
enabled directly from the operator interface of the wireless 
computing device." 
(emphasis added) 

Furthermore, Cups and Behr, alone or in combination, fail to disclose, 

teach, or suggest at least the aspect of independent claim 33 wherein: 

659742 vi 

" ... applications or data are synchronized between the 
central database and the second storage medium and wherein 
the applications program interface and communications 
control module establish a seamless link between the data in 
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the central database and the data on the second storage 
medium." 
(emphasis added) 

The Examiner also states: 

"Behr teaches wireless handheld computing device on which 
hospitality application (see col. 14, lines 1-57)." 

Applicants respectfully disagree. Behr discloses "a method of providing 

route guidance information and other information from a base unit to a mobile unit in response to 

a request from the mobile unit" (see Behr, Col. 4 Ln. 28-31). Behr explains that the mobile unit 

sends the request for route guidance as a "query message 120" including a "destination field 

144" and a "destination type field 146", and, for example, that the "destination type field 146 

~ may be 'restaurant', and the destination field 144 may be 'McDonald's"' (see Behr, Col. 14 Ln. 

37-44). Behr also discloses that other specifiable destinations include "airport[s]" and 

~=; "museum[s]" (see Behr, Col. 14 Ln. 42). 

However, Applicants submit that simply stating that a mobile unit may 

request from a navigation system directions to a restaurant does not constitute disclosure of a 

hospitality software application. As known in the art, a hospitality software application is, for 

example, a piece of software used to provide operational solutions in hospitality industries such 

as restaurants and hotels concerning, for example, food ordering, menus, wait-lists and 

reservations. Accordingly, Applicants submit that Behr fails to teach a "wireless handheld 

computing device on which hospitality application" as suggested by the Examiner. 

In light of at least the above, Applicants submit that independent claims 

29, 32, and 33 are in condition for allowance. As claims 30, 31, 34, 40-48, and 93 depend 

therefrom, these claims, for at least the above-identified reasons, are also thought to be 

allowable. 
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IV. Conclusion and Authorization 

Applicants believe that all pending claims are allowable over the cited art. 

The Commissioner is hereby authorized to charge any additional fees 

which may be required for this amendment, or credit any overpayment to Deposit Account No. 

13-4500, Order No. 3125-4002. A DUPLICATE OF THIS DOCUMENT IS ATTACHED. 

In the event that an extension of time is required in addition to that 

requested in a petition for an extension of time, the Commissioner is requested to grant a petition 

for that extension of time which is required to make this response timely and is hereby 

authorized to charge any fee for such an extension of time or credit any overpayment for an 

extension of time to Deposit Account No. 13-4500, Order No. 3125-4002US1. A DUPLICATE 

OF THIS DOCUMENT IS ATTACHED. 

November 1, 2001 
MORGAN & FINNEGAN, L.L.P. 
345 Park Avenue 
New York, NY 10154 
(212)758-4800 I (212)751-6849 (facsimile) 
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UNITED STATES PATENT APPLICATION 

2 
3 OF: KEITH R. McNALLY 
4 WILLIAM H. ROOF 
5 RICHARD BERGFELD 
6 
7 
8 FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS 
9 COMMUNICATIONS SYSTEM WITH MENU 

10 ~G~E~N~E~RA~T~IO~N~--------------------------
11 

12 The present application is a continuation of application Serial No. 09/400,413, 

13 filed September 21, 1999. The contents of application Serial No. 09/400,413 are incorporated 

14 herein by reference . 
. ~~: 
tJ 15 FIELD OF THE INVENTION 

"f:& 16 This invention relates to an information management and synchronous 

~jl7 communications system and method for generation of computerized menus for restaurants and 

~~18 other applications with specialized display and synchronous communications requirements 
" 

~9 related to, for example, the use of equipment or software with non-PC-standard graphical 

~Z20 formats, display sizes and/or applications for use in remote data entry, information management 

~''21 and synchronous communication between host computer, digital input device or remote pager 

22 via standard hardwired connection, the internet, a wireless link, smart phone or the like. 

23 BACKGROUND OF THE INVENTION 

24 While computers have dramatically altered many aspects of modem life, pen and 

25 paper have prevailed in the hospitality industry, e.g., for restaurant ordering, reservations and 

26 wait-list management, because of their simplicity, ease of training and operational speed. For 

27 example, ordering prepared foods has historically been done verbally, either directly to a waiter 
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1 or over the telephone, whereupon the placed order is recorded on paper by the recipient or 

2 instantly filled. 

3 Although not previously adapted for wide-scale use in the hospitality industry, 

4 vanous forms of digital wireless communication devices are in common use, e.g., digital 

5 wireless messengers and pagers. Also in common use are portable laptop and handheld devices. 

6 However, user-friendly information management and communication capability not requiring 

7 extensive computer expertise has not heretofore been available for use in everyday life such as 

8 for restaurant ordering, reservations and wait-list management. Hundreds of millions of dollars 

9 have been spent on personal digital assistant ("PDA'') development seeking to produce a small, 

~d~ 10 light-weight and inexpensive device that could be adapted to such uses; yet none have yielded a 
n 
::do 

' ' 1 1 ~"":.:; 

i:.::i: 
satisfactory solution. 

' f.::::! 
~.iq 12 ' ' .. ~~ One of the inherent shortcomings of PDA type devices is that, as they strive for 

r~ 
13 

~~Q 
small size, low weight and low cost, they must compromise the size and clarity of the operator 

" 
F= 14 display medium interface itself, which in most cases is one of a variety of LCD (liquid crystal 
~~ 

~-=-~ 15 display) type devices. As the size of the display shrinks, the amount of information that may be 
~=~ 

t.J 16 displayed at any one point or time is commensurately decreased, typically requiring multiple 
'' r-:~ 

17 screens and displays to display information to the operator. This reduces the overall utility of the 

18 device. Additionally, the smaller display and keyboard results in a non-optimal operator 

19 interface, which slows down operation and is thus unacceptable for the time criticality of 

20 ordering, reservation and wait-list management and other similar applications. This necessitates 

21 many design compromises which in the aggregate have resulted in limited acceptance of PDA 

22 type devices in the restaurant and hospitality fields. 

- 3-
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1 Many of the negatives prevalent in earlier devices have been eliminated, but, to 

2 date, there is still no integrated solution to the ordering/waitlist/reservation problem discussed 

3 above. With the advent of the Palm® and other handheld wireless devices, however, the efforts 

4 to make such devices ubiquitous have begun to bear fruit at least in some areas, e.g., personal 

5 calendars. However, substantial use of such devices in the restaurant and hospitality context has 

6 not occurred to date. As discussed above, at least one of the reasons PDAs have not been 

7 quickly assimilated into the restaurant and hospitality industries is that their small display sizes 

8 are not readily amenable to display of menus as they are commonly printed on paper or displayed 

9 on, e.g. , large, color desktop computer screens. Another reason is that software for fully 

::-;:;;;::;: 10 realizing the potential for wireless handheld computing devices has not previously been 
{:1 
~d 11 available. Such features would include fast and automatic synchronization between a central 

12 
ec.. :: 

database and multiple handheld devices, synchronization and communication between a World 

13 Wide Web ("Web") server and multiple handheld devices, a well-defined application program 

;: 

~:::.=.:: 14 interface ("API") that enables third parties such as point of sale ("POS") companies, affinity 

~~~ 
A 15 -:..::::=:== program companies and internet content providers to fully integrate with computerized 
f:i.:: 

16 hospitality applications, real-time communication over the internet with direct connections or 
F==-~ 

17 regular modem dialup connections and support for batch processing that can be done periodically 

18 throughout the day to keep multiple sites in synch with the central database. A single point of 

19 entry for all hospitality applications to communicate with one another wirelessly has also 

20 previously been unavailable. Such a single point of entry would work to keep all wireless 

21 handheld devices and linked Web sites in synch with the backoffice server (central database) so 

22 that the different components are in equilibrium at any given time and an overall consistency is 

23 achieved. For example, a reservation made online would be automatically communicated to the 

- 4-
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1 backoffice server and then synchronized with all the wireless handheld devices wirelessly. 

2 Similarly, changes made on any of the wireless handheld devices would be reflected 

3 instantaneously on the backoffice server, Web pages and the other handheld devices. 

4 For the foregoing reasons, paper-based ordering, waitlist and reservations 

5 management have persisted in the face of widespread computerization in practically all areas of 

6 commerce. At most, computerization of these functions has been largely limited to fixed 

7 computer solutions, i.e., desktop or mainframe, because of the problems heretofore faced in 

8 configuring wireless handheld devices and maintaining database synchronization for such 

9 applications. Specifically, the unavailability of any simple technique for creating restaurant 

10 menus and the like for use in a limited display area wireless handheld device or that is 

11 compatible with ordering over the internet has prevented widespread adoption of 

12 computerization in the hospitality industry. Without a viable solution for this problem, 

13 organizations have not made the efforts or investments to establish automated interfaces to 

~ 

14 handheld and Web site menus and ordering options. 

15 A principal object of the present invention is to provide an improved information 

16 management and synchronous communications system and method which facilitates user-

17 friendly and efficient generation of computerized menus for restaurants and other applications 

18 that utilize equipment with non-PC-standard graphical formats, display sizes and/or applications. 

19 A further object of the present invention is to provide an improved information 

20 management and synchronous communications system and method which provides for entry, 

21 management and communication of information from the operator as well as to and from another 

22 computer, Web page menu, remote digital device using a standard hardwired connection, the 

23 internet or a wireless link. 

- 5-

658960 vi 



 25Petitioners' Exhibit 1007, Page

' t 

. 

f.: 

1 

' 
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A further object of the present invention is to provide an improved information 

2 management and synchronous communications system which is small, affordable and 

3 lightweight yet incorporates a user-friendly operator interface and displays menus in a readily 

4 comprehensible format. 

5 A further object of the present invention is to provide a synchronous information 

6 management and communications system which enables automatic updating ofboth wireless and 

7 internet menu systems when a new menu item is added, modified or deleted from any element of 

8 the system. 

9 SUMMARY OF THE INVENTION 

10 The foregoing and other objects of the present invention are provided by a 

11 synchronous information management and communications system and method optimized for 

12 simplicity of operation which incorporates menu generation for creation of menus to be used 

13 with wireless remote handheld computer and PDA devices, the internet or any application where 

14 simple and efficient generation of menus is appropriate. The menu generation approach of the 

15 present invention includes a desktop software application that enables the rapid creation and 

16 building of a menu and provides a means to instantly download the menu configuration onto, 

17 e.g., a handheld device or Web page and to seamlessly interface with standard point of sale 

18 ("POS") systems to enable automatic database updates and communication exchanges when a 

19 change or input occurs in any of the other system elements. To solve the above and other related 

20 problems, an information management and communications system is provided which results in 

21 a dramatic reduction in the amount of time, and hence cost, to generate and maintain 

22 computerized menus for, e.g., restaurants and other related applications that utilize non-PC-

23 standard graphical formats, display sizes or applications. 
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1 The menu generation approach of the present invention has many advantages over 

2 previous approaches in solving the problem of converting paper-based menus or Windows® PC-

3 based menu screens to small PDA-sized displays and Web pages. In one embodiment, the 

4 present invention is a software tool for building a menu, optimizing the process of how the menu 

5 can be downloaded to either a handheld device or Web page, and making manual or automatic 

6 modifications to the menu after initial creation. 

7 The use of wireless handheld devices in the restaurant and hospitality industry is 

8 becoming increasingly pervasive as restaurant owners and managers become more aware of the 

9 benefits. With the proper wireless handheld system in place, restaurants can experience 

f.-.J~ 

Q 
10 increased table turns from improved server productivity and shorter order taking and check 

~~ 
1 1 paying times. Restaurants and POS companies seeking to provide a wireless handheld interface 

~Ji 12 ~ .. ~ to their desktop-based POS systems or a Web page equivalent face several challenges. These 

ffJ 
~JJ 13 challenges include building a menu using their existing database and transferring the menu onto 
;; 
::: F.;;l 14 handheld devices or Web pages that will interface with servers wirelessly or to 
~::£~ 

~:J 15 restaurants/customers over the internet. The menu generation approach of the present invention 
~~i::; 

r==~ 
16 ~.c:::::O 

~::::§.; 
is the first coherent solution available to accomplish these objectives easily and allows one 

17 development effort to produce both the handheld and Web page formats, link them with the 

18 existing POS systems, and thus provides a way to tum a complicated, time-consuming task into a 

19 simple process. 

20 The information management and synchronous communications system of the 

21 present invention features include fast synchronization between a central database and multiple 

22 handheld devices, synchronization and communication between a Web server and multiple 

23 handheld devices, a well-defined API that enables third parties such as POS companies, affinity 
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1 program companies and internet content providers to fully integrate with computerized 

hospitality applications, real-time communication over the internet with direct connections or 

regular modem dialup connections and support for batch processing that can be done periodically 

throughout the day to keep multiple sites in synch with the central database. 

The communication module also provides a single point of entry for all hospitality 

applications, e.g., reservations, frequent customer ticketing, wait lists, etc. to communicate with 

one another wirelessly and over the Web. This communication module is a layer that sits on top 

of any communication protocol and acts as an interface between hospitality applications and the 

communication protocol and can be easily updated to work with a new communication protocol 

without modifying the core hospitality applications. A single point of entry works to keep all 

wireless handheld devices and linked web sites in synch with the backoffice server applications 

so , that the different components are in equilibrium at any given time and an overall consistency 

is achieved. For example, a reservation made online can be automatically communicated to the 

backoffice server and then synchronized with all the wireless handheld devices wirelessly. 

Similarly, changes made on any of the wireless handheld devices are reflected instantaneously on 

the backoffice server Web pages and the other handheld devices. 

BRIEF DESCRIPTION OF THE DRAWINGS 

The foregoing features and advantages of the present invention can be appreciated 

more fully from the following description, with references to the accompanying drawings in 

20 which: 

21 FIG. 1 is a schematic representation of a window displayed on a computer display 

22 screen which shows a hierarchical tree menu, modifier window and sub-modifier window in 

23 conformity with a preferred embodiment of the present invention. 

- 8 -
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FIG. 2 is a schematic representation of a modifier dialog box in conformity with a 

2 preferred embodiment of the present invention. 

3 FIG. 3 is a schematic representation of a menu category dialog box in conformity 

4 with a preferred embodiment of the present invention. 

5 FIG. 4 is a schematic representation of a menu item dialog box in conformity with 

6 a preferred embodiment of the present invention. 

7 FIG. 5 is a schematic representation of a display customization dialog box in 

8 conformity with a preferred embodiment of the present invention. 

9 FIG. 6 is a schematic representation of a communications control window in 

10 
-r-::~ 

conformity with a preferred embodiment of the present invention. 
~.:-;:=~ 

r~ 1 1 :;=· FIG. 7 is a schematic representation of a point of sale interface on a wireless 

l~ 12 handheld device for use in displaying page menus created in conformity with a preferred 

rJ=-~ 
;£] 13 embodiment of the present invention. 
~ 

~ : ,...... 

f:b 14 DETAILED DESCRIPTION OF THE INVENTION 
~J 
g:~b 15 Most personal computers today run under an operating system that provides a 

~:~ 16 graphical user interface ("GUI") for accessing user applications. A GUI is used in the preferred 

17 embodiment of the present invention. Through an interface of windows, pull-down menus, and 

18 toolbars, GUI operating systems have simplified PCs and have rendered computer technology 

19 more user friendly by eliminating the need to memorize keyboard entry sequences. In addition, 

20 GUis allow users to manipulate their data as they would physical entities. For example, a 

21 window can represent a file and the contents of the window can represent the records of the file. 

22 The window can be opened, closed, or set aside on a desktop as if it were an actual object. The 

23 records of the file can be created, deleted, modified and arranged in a drag-and-drop fashion as if 
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' ' . 
they also were physical objects. The most common GUI operating systems that provide this 

2 "object-oriented" environment for personal computers are Microsoft Windows® systems, 

3 including Windows CE® for handheld wireless devices and the like. Generally, a particular 

4 application program presents information to a user through a window of a GUI by drawing 

5 images, graphics or text within the window region. The user, in tum, communicates with the 

6 application by "pointing" at graphical objects in the window with a pointer that is controlled by a 

7 hand-operated pointing device, such as a mouse, or by pressing keys on a keyboard. 

8 The use of menus is conventional in GUis for software applications. Menus are 

9 typically utilized to provide end users of applications with available choices or processing 

options while using the applications. For example, in a typical desktop or interactive application, 

selection of a "file" from a menu bar may cause display of a context menu which provides "file" 

\~ 12 options. File options can have additional subordinate or child options associated with them. If a 

"~ 13 file option having subordinate options is selected, the child options are displayed in context in a 

~ 14 child menu or submenu proximate to the selected parent option. One or more of the child 

options provided in the child menu may have further subordinate options. Thus, such a menu 

system comprises cascading sets of menus which are displayable in context to show the 

17 parent/child relationships between options of the context menu. A menu system of this type is 

18 incorporated into the preferred embodiment of the invention. 

19 The preferred embodiment of the present invention uses typical hardware 

20 elements in the form of a computer workstation, operating system and application software 

21 elements which configure the hardware elements for operation in accordance with the present 

22 invention. A typical workstation platform includes hardware such as a central processing unit 

23 ("CPU"), e.g., a Pentium® microprocessor, RAM, ROM, hard drive storage in which are stored 
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1 various system and application programs and data used within the workstation, modem, display 

2 screen, keyboard, mouse and optional removable storage devices such as floppy drive or a CD 

3 ROM drive. The workstation hardware is configured by software including an operating system, 

4 e.g., Windows® 95, 98, NT or CE, networking software (including internet browsing software) 

5 and application software components. The preferred embodiment also encompasses a typical file 

6 server platform including hardware such as a CPU, e.g., Pentium® microprocessor, RAM, ROM, 

7 hard drive, modem, and optional removable storage devices, e.g., floppy or CD ROM drive. The 

8 server hardware is configured by software including an operating system, e.g. , Windows® 95, 98, 

9 NT or CE, networking software (including Web server software) and database software. 

~= 
-~~~ 

10 A computer workstation for use in the preferred embodiment also includes a GUI. 

g 
:~ ~ 1 1 ;t.._;:~ 

~,-" 
As is conventional, the GUI is configured to present a graphical display on the display screen 

:\:4 12 arranged to resemble a single desktop. Execution of an application program involves one or 

'i.~ 13 more user interface objects represented by windows and icons. Typically, there may be several 

~.b 14 windows and icons simultaneously present on the desktop and displaying information that is 

generated by different applications. 

16 The window environment is generally part of the operating system software that 

17 includes a collection of utility programs for controlling the operation of the computer system. 

18 The computer system, in tum, interacts with application programs to provide higher level 

19 functionality, including a direct interface with the user. Specifically, the application programs 

20 make use of operating system functions by issuing task commands to the operating system which 

21 then performs the requested task. For example, an application program may request that the 

22 operating system display certain information on a window for presentation to the user. 
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1 An aspect of the preferred embodiment of the information management and 

2 communications system of the invention is shown in FIG. 1. FIG. 1 shows an example of the 

3 GUI provided by the operating system of the preferred embodiment of the present invention. 

4 With reference to FIG. 1, the preferred embodiment includes an intuitive GUI 1 from which to 

5 build a menu on a desktop or other computer. A hierarchical tree structure 2 is used to show the 

6 different relationships between the menu categories 3 (e.g. , soups, salads, appetizers, entrees, 

7 deserts, etc.), menu items 4 (e.g., green salad, chicken caesar salad, etc.), menu modifiers 5 (e.g., 

8 dressing, meat temperature, condiments, etc.) and menu sub-modifiers 6 (e.g., Italian, French, 

9 ranch, bleu cheese, etc.). 

~~ 10 
.. A 

The procedure followed in configuring a menu on the desktop PC and then 
::= _.,_ 
¥=~ 1 1 
t:;~ 

downloading the menu configuration onto the POS interface on the handheld device in 

~~f~ 
12 

'"~-~ 
conformance with the preferred embodiment is as follows. 

r~ 
~~J 13 The menu configuration application is launched by clicking on the appropriate 
~ 

Fi~ 14 icon on the desktop display screen. FIG. 1 will then be displayed. There are three windows on 
~_::. 

tJ 15 
~d 

the screen shown in FIG. 1. The left window is the menu tree 7, also called the tree view. The 

~-;::;~ 

~~::::~ 16 
f== 

top right window is the Modifiers window 8 and the bottom right window is the Sub-Modifiers 

17 window 9. The Sub-Modifiers window lists the sub-modifiers that correspond to the modifier 

18 that is selected. The views on the right are referred to as list views. There are several ways of 

19 invoking a command, including using the menu options; using the context menu (right mouse 

20 click); using the keyboard or using the toolbar icons. For example, if it is desired to add a 

21 category to the menu, the following four options are available: (1) clicking on Edit, Add 

22 Category; (2) right mouse clicking on Menu, then clicking on Add Category; (3) highlighting 

23 Menu, then typing Ctrl +Tor (4) clicking on the Add Category icon on the toolbar. To add an 
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1 item to a category, the following options are available: (1) highlighting the category to which it 

2 is desired to add an item and then clicking on Edit> Add Item; (2) right mouse clicking on the 

3 desired category and then clicking on Add Item; (3) highlighting the desired category, then 

4 typing Ctrl + N or ( 4) clicking on the Add icon on the toolbar. 

5 When building a menu, it should be kept in mind that the menu items are stored 

6 using a tree metaphor similar to how files are stored on a PC with folders and subfolders. The 

7 menu structure is similar to the Windows® File Explorer in the way the items are organized 

8 hierarchically. Below is an example of how an item may be configured: 

9 Menu 
10 >> Entrees 

r::: 
~=.: 

11 >> Red Meat 

~~ 12 
13 r:::: 
14 ~~ 

>> NY Strip 
>> Vegetables 

>> Tomato 
;~~~ 15 >> Lettuce 

r~~ 16 Meat Temperature 
~~~ 17 >> Medium Rare 
::'.! 18 
~~~ 19 In the above example, Menu is the root. Entrees is a menu category. Red Meat is an Entree .. .. 
f~: 

.t::::~ 

6:.~ 20 
~=~~ 

category. NY Strip is a modifier. Vegetable is a modifier. Meat Temperature is a modifier. 

~J 21 f.:§; Medium Rare is a sub-modifier of Meat Temperature. 

22 The steps taken in building a menu are as follows: 

23 1. Add Modifiers; 

24 2. Add Sub-Modifiers and link them to the Modifiers; 

25 3. Create Menu categories; 

26 4. Add menu items to the categories; 

27 5. Assign Modifiers to the menu items; 

28 6. Preview the menu on the POS emulator on the desktop PC; 

29 7. Download the menu database to the handheld device. 
30 
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1 To add modifiers, a user clicks on the inside of the Modifiers window, then (1) 

2 clicks on Edit>Add Modifier; (2) Presses Ctrl + N; (3) right mouse clicks in the Modifiers 

3 window, then clicks on Add Modifiers or (4) clicks on the Add icon from the toolbar. If a menu 

4 is being built from scratch, the procedure is to enter the Long Name, Short Name, Code and 

5 Price in the Modifier dialog box 10 shown in FIG. 2. The Long Name is the full descriptive 

6 name of the item. The Short Name is the abbreviated name that will be displayed on the 

7 handheld device. The Code is the numeric or alphanumeric code for the item. If there is an 

8 existing database, the existing database can be browsed and menu items retrieved from the 

9 database. Clicking on the Browse button will bring up the existing database of menu items. The 

item to be added is then selected and "OK" is clicked. The fields will then be filled with the 

information from the database. Clicking on OK again will add the item as a modifier. To delete 

a modifier, the modifier is selected and the Delete key pressed on the keyboard. To edit a 

modifier, either the modifier is double clicked or the Enter key is pressed. 

Sub-modifiers represent the last level of modifiers that can be assigned to a menu 

6) 15 tree. To add sub-modifiers, the modifier to which sub-modifiers are to be assigned is selected. 

Then, the focus is set on the sub-modifier window by clicking inside the Sub-Modifier window 

17 as follows: (1) clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl + N; (3) right mouse 

18 clicking in the Sub-Modifiers window, then clicking on Add Sub-Modifiers or (4) clicking on the 

19 Add icon from the toolbar. If a menu is being built from scratch, the procedure is to enter the 

20 Long Name, Short Name, Code and Price in a Sub-Modifier dialog box similar to the Modifier 

21 dialog box shown in FIG. 2. As with modifiers, the Long Name is the full descriptive name of 

22 the item. The Short Name is the abbreviated name that will be displayed on the handheld device. 

23 The Code is the numeric or alphanumeric code for the item. As before, if there is an existing 
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1 database, the existing database can be browsed and menu items retrieved from the database. 

2 Clicking on the Browse button will bring up the existing database of menu items. The item to be 

3 added is then selected and OK clicked. The fields will then be filled with the information from 

4 the database. Clicking on OK again will add the item as a sub-modifier. To delete a sub-

5 modifier, the sub-modifier is selected and the Delete key depressed on the keyboard. To edit a 

6 sub-modifier, either the sub-modifier is double clicked or the Enter key is pressed. 

7 Menu categories are created from the root. Some examples of categories are 

8 Appetizers, Soups, Salads, Entrees, Desserts, etc. The first step is to click on Menu in the menu 

9 tree window. Categories are added by (1) clicking on the Add Category icon from the toolbar; 

(2) clicking on Edit > Add Category or (3) pressing Ctrl + T. As shown in FIG. 3, Menu 

Category dialog box 11 then appears in which to enter the Long and Short names for the menu 

category. 

To add menu items to categories, the menu category which is being built is 

~!k 14 clicked. For example, if items are being added to Appetizers, the Appetizers branch is clicked 

on. Then the Edit> Add Item is clicked on or Ctrl + N pressed. As before, if a menu is being 

built from scratch, the procedure is to enter the Long Name, Short Name, Code, Prep Time, 

17 Recipe and Price into the Menu Item dialog box 12 shown in FIG. 4. The Long Name is the full 

18 descriptive name of the item. The Short Name is the abbreviated name that will be displayed on 

19 the handheld device. The Code is the numeric or alphanumeric code for the item. Prep Time is 

20 the time it takes to prepare the meal and Recipe would include preparation methods and 

21 ingredients that are used in the preparation of the item. If there is an existing database, the 

22 existing database can be browsed and menu items retrieved from the database. Clicking on the 

23 Browse button will bring up the existing database of menu items. The item to be added is then 
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1 selected and OK is clicked. The fields will then be filled with the information from the database. 

2 Clicking on OK again will add the item to the category. 

3 Once the menu items have been entered, it may be desired to assign some 

4 modifiers to the menu items. For example, it may be desired to assign meat temperature to a 

5 steak order. To accomplish this, first the modifier to be assigned is selected, then the menu item 

6 on the tree view that is to be assigned the modifier is clicked on and then Edit > Assign Modifier 

7 is clicked on. Or, the modifier can simply be dragged and dropped onto the menu item to link 

8 them. A dialog box is then displayed asking if this modifier is a required modifier. If it is a 

9 required modifier, the display icon will be red but if it is a non-required modifier the display icon 

10 will be green. As many modifiers as are applicable can be assigned. If any changes are made to 
t~ 
r :== 

11 ~;:::::f! 

~£:: 
the modifiers, those changes will be automatically reflected throughout the menu tree. 

1i;."':":l 
~: ~ 12 Once the modifiers have been entered, it may be desired to assign sub-modifiers 

riJ 13 to the modifiers items. For example, it may be desired to add Honey Mustard as a sub-modifier 

F. 

'. 14 := to Dressing. To accomplish this, first the modifier to be assigned a sub-modifier is selected, then 
F 
r~ 15 1¥:~::-.:: the sub-modifier window is clicked on, then Edit > Add Sub Modifier is clicked on, Ctrl+N 

16 
~* 

entered or the Add icon from the toolbar is clicked on. Or, the sub-modifier can simply be 

17 dragged and dropped onto the modifier to link them. 

18 When the menu has been completely configured, it can be previewed on a POS 

19 emulator on the desktop to verify that the menu is correctly configured before downloading it to 

20 the handheld device. To preview, File> Preview Database is clicked on or the Preview Database 

21 icon from the toolbar is clicked on. The handheld POS emulator on the desktop can then be run. 

22 If the configuration is deemed acceptable, the handheld device is connected to the desktop PC to 

23 ensure that a connection has been established; the POS application on the handheld device is 

- 16-

658960 vl 



 36Petitioners' Exhibit 1007, Page

1 exited and File > Download Database is clicked on or the Download Database icon from the 

2 toolbar is clicked on. If there is an existing menu database on the handheld device, the system 

3 will ask if the existing database should be replaced. Yes is clicked if existing database 

4 replacement is desired. 

5 A database function enables the creation of, e.g., a breakfast menu, lunch menu 

6 and dinner menu and downloading them to a handheld device. Functions available are (1) 

7 creating a new database; (2) opening an existing database; (3) saving a database under a different 

8 name. To access these functions, File is clicked on the menu bar. 

9 The preferred embodiment encompasses customized layout, views and fonts. To 

10 
bl 

set the focus on the view it is desired to change, click inside the desired window. The main 

l-J 1 1 
~ ~ 

customizing dialog box is accessed by clicking on View> Customize View. A dialog box 13, as 
if=• 

:.!;;.~ 12 shown in FIG. 5, will be displayed including tabs that allow the following options: selection of 

13 Columns to display in the list view by choosing and arranging the fields to display in the 
!i 

~d~ 14 Modifiers and Sub-Modifiers windows; formatting Columns by specifying the column widths 
~~.:£; 

r-·~ 15 and justification; selecting Filter allows restricting the list to display only the items that meet 
t;;:::~: 

16 certain criteria. For example, display of modifiers with codes between 500 and 550. Selecting 

17 Sort allows sorting the modifiers or sub-modifiers according to any of the available fields such as 

18 Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change 

19 the font in a particular window, click on View > Fonts or right mouse click in the desired 

20 window and then click on Fonts. To change the size of the windows, drag the borders of the 

21 windows to expand or contract the size of the windows. To change the column widths, simply 

22 drag the edge of the column headers to increase or decrease the column widths. 
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1 A communications control program monitors and routes all communications to 

2 the appropriate devices. It continuously monitors the wireless network access point and all other 

3 devices connected to the network such as pagers, remote devices, internet Web links and POS 

4 software. Any message received is decoded by the software, and then routed to the appropriate 

5 device. No user action is needed during operation of the software once the application has been 

6 launched. To launch the communications control module, a Wireless Traffic icon is clicked on 

7 the desktop PC. When the program loads, the screen shown in FIG. 6 appears. Messages 

8 received are logged in the window 14 shown in FIG. 6 with a time stamp. The messages are also 

9 logged to a file on the hard drive. This provides a mechanism to monitor all traffic across the 

network (possibly useful for troubleshooting, or maintenance, but not necessary for normal 

operation). The program may be minimized so the screen is not displayed on the desktop, but it 

must be running for proper communications to exist between all devices on the network. 

As stated, the preferred embodiment of the present invention includes the use of 

and compatibility with GUI technology. A drag-and-drop approach is used for organizing the 

tree structure 2 in the generated menu. Drag-and-drop is also used for assigning modifiers 

(modifiers can be dragged from the modifiers window 5 and dropped onto the menu item 4 for 

17 assignment). In-cell editing results in fast editing of items in building the menus. Customizable 

18 fonts enable users to change font types, style and size. Customizable layouts enable users to 

19 resize windows, change icons and display preferences. The inventive approach provides for 

20 fully persistent storage between sessions, even if a session is improperly or abruptly terminated. 

21 Font and the tree state (i.e., which nodes are expanded/collapsed) are stored between sessions. 

22 Layout for modifiers and sub-modifiers list views (filter, columns, formatting, font, etc.) are 

23 stored between sessions. The last database used is likewise stored between sessions. Splitter 
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1 views allow the user to see different views at the same time. Each view is displayed on its own 

2 section of the screen. Views can be resized via the keyboard or a mouse by simply dragging the 

3 splitter in the middle. 

4 An automated function is provided to import existing POS databases into the 

5 inventive menu generation system and, as discussed above with respect to the detailed example 

6 of how to use the preferred embodiment, an automated download procedure is provided to 

7 transfer the desktop database onto a handheld device and/or Web page. Also as discussed, the 

8 preferred embodiment facilitates preview of the handheld device or Web page version of the 

9 POS menu on the desktop before downloading and configuration. Customizable desktop menu 

10 generation is contemplated, as discussed above, in the form of customizable fonts, columns, 
l..J 
~~~ 1 1 
~~.¢. 

layouts, etc. The inventive approach also includes templates for common modifiers that can be 
i:' " ~~ 
~~ § 12 :~-4 assigned to similar menu items. The preferred embodiment also supports multiple databases, 

r¥J 
13 ~~ thus providing for the creation and storing of different menu databases on handheld devices such 

~ 14 as breakfast, lunch or dinner menus. The user can then select the appropriate database to reflect 
~~; 

\"'=; 15 !':::;== 
i . 

the time of day. 
f.~= 
;c:~ 

f;:J 16 FIG. 7 is a schematic representation of a point of sale interface 15 for use in 
f"'' 

17 displaying a page-type menu 16 created using the inventive menu generation approach. As can 

18 be seen from FIG. 7, the page menu is displayed in a catalogue-like point-and-click format 

19 whereas the master menu, FIG. 1, is displayed as a hierarchical tree structure. Thus, a person 

20 with little expertise can "page through" to complete a transaction with the POS interface and 

21 avoid having to review the entire menu of FIG. 1 to place an order. A PDA or Web page format 

22 could appear like FIG. 7 or the display could be configured for particular requirements since 

23 fully customizable menu generation and display are contemplated. 
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.· 

The POS interface on the handheld device supports pricing in the database or 

2 querying prices from the POS server. The POS device also can be customized with respect to 

3 "look and feel" for the particular version. As can be seen in FIG. 7, the POS interface provides 

4 for billing, status and payment with respect to orders. A myriad of options can be provided 

5 depending on the application. 

6 Advanced database functions are provided in the preferred embodiment of the 

7 invention, including an automated download process onto handheld devices and/or Web sites. In 

8 the preferred embodiment, the menu generation system of the present invention uses an API 

9 called ActiveX Data Objects ("ADO") for database access. ADO is useful in a variety of 

f:~d: 10 
;."'"\ 

settings. It is built on top of OLE DB and can be used to talk to databases and, in the future, any 
;::!: 
~=~ 1 1 data source with any OLE DB driver. Advanced querying is supported. The database can be 

~f1 12 ::...~ queried on virtually all fields. Queries can be built using SQL syntax for experienced users or 

13 can be created using a query builder which guides users through the creating process. Advanced 
iS 

~ 14 error handling is supported. Errors occurring at run time can be trapped. A descriptive message 
~~ 

G 15 
~.~ 

is displayed to alert the user and provide error information. However, the application does not 

~~:::::;; 

::r._~ 16 
~::. 

terminate when the errors happen. The source code is easy to maintain and modify, thus 

17 allowing for on time delivery of customized versions of the software. The advanced database 

18 functions produce well-designed databases that accommodate growth and scalability 

19 The inventive menu generation approach provides a solution for the pervasive 

20 connectivity and computerization needs of the restaurant and related markets. The inventive 

21 solution includes automatic database management and synchronization, PDA and handheld 

22 wireless operating system integration and optimization, wireless communications and internet 

23 connectivity, user interface design, and graphics design. 
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1 In the preferred embodiment, the menu generation approach of the present 

2 invention uses Windows CE® as the operating system for the handheld devices. Windows CE® 

3 provides the benefits of a familiar .Windows 95/98/NT® look and feel, built-in synchronization 

4 between handheld devices, internet and desktop infrastructure, compatibility with Microsoft 

5 Exchange®, Microsoft Office 9® and TCP/IP quick access to information with instant-on feature. 

6 Windows CE® provides a basic set of database and communication tools for 

7 developer use. However, interfacing with these tools to provide application specific results can 

8 be a complex task. In addition to the menu generation described above, a set of software 

9 libraries described herein in conformance with the present invention not only enhances the basic 

·r-Y 10 Windows CE® functionality by adding new features but also maximizes the full potential of 
--"-g 
~~~ 11 
~~~ 

wireless handheld computing devices. Such features include fast synchronization between a 

~.::.~ 12 central database and multiple handheld devices, synchronization and communication between a 

13 
i'i 

Web server and multiple handheld devices, a well-defined API that enables third parties such as 

~~~:: 

14 POS companies, affinity program companies and internet content providers to fully integrate 

~~ 
f==: .. 15 with computerized hospitality applications, real-time communication over the internet with direct 

f=:=: 16 connections or regular modem dialup connections and support for batch processing that can be 

17 done periodically throughout the day to keep multiple sites in synch with the central database. 

18 The synchronous communications control module discussed above provides a 

19 single point of entry for all hospitality applications to communicate with one another wirelessly 

20 or over the Web. This communications module is a layer that sits on top of any communication 

21 protocol and acts as an interface between hospitality applications and the communication 

22 protocol. This layer can be easily updated to work with a new communication protocol without 

23 having to modify the core hospitality applications. The single point of entry works to keep all 
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;; 2 
12 ·~:~ 

13 

"' 
~~ 14 

~J 15 .. 
r-..:~ 

~""'" r;:::::-.:: 16 
'· !f:ci:: 

17 

18 

19 

20 

21 

22 

wireless handheld devices and linked Web sites in synch with the backoffice server (central 

database) so that the different components are in equilibrium at any given time and an overall 

consistency is achieved. For example, a reservation made online is automatically communicated 

to the backoffice server which then synchronizes with all the wireless handheld devices 

wirelessly. Similarly, changes made on any of the wireless handheld devices will be reflected 

instantaneously on the backoffice server and the other handheld devices. 

The software applications for performing the functions falling within the 

described invention can be written in any commonly used computer language. The discrete 

programming steps are commonly known and thus programming details are not necessary to a 

full description of the invention. 

A simple point-to-point wireless capability is contemplated which permits simple 

digital messages to be sent from the wireless handheld devices to a receiver in a beeper and/or 

valet parking base-station. The POS interface of FIG. 7 is representative of the display on a 

typical wireless device used in conformity with the invention. A simple protocol is used to 

acknowledge receipt of the message and thus simultaneous communication is not necessary, 

which reduces the cost of the wireless link. The range of the wireless link is determined by the 

characteristics of the radio transceiver. Adding a wireless link allows paging of beeper equipped 

customers directly from the operator interface on the wireless handheld devices and 

communication to and from various input/output transmitters and receivers to update the status 

of the order, reservation or other information and thus further reduce the workload on the 

operator and enable operations to proceed much faster. This link could also be hardwired or 

otherwise implemented using any two-way messaging transport. 
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